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Author: Kristenson, Joel
Last Updated: 2016-09-21

Overview

This article shows how to thank people for the total amount they donated, at an event, via a mass email campaign — it utilizes a new merge field
called <<EventContributionTotal>>.

This was a request a customer had in 2016. If you have a request for a feature that doesn’t exist you can drop us a line through the Start Page
Comment Box when you first log into the program.

¢« Tip: Learn how to create email templates, and schedule mass email campaigns in this 20 minute how-to video.
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Steps

Navigate to the Contributions list under the Application Menu. Requires appropriate security clearance.
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Search by the event you’re thanking people for spending money at. In this example | searched by an event called ‘2016 Celebrity Golf Tournament’
which produced 136 transactions.
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2 1

<3 Search F. Reset | db New o | B O @ File » Edit - |« | ApplytoPledges | Contributions

Favorites | General |Ma'mxyﬂ-!mw|0mer |Gamay|Cmiad|5CIL |

o

~ [ﬂ:ustum, according to dates below> V] Products: <ignore> -
Date Range:
[ [+  Recurrence: <ignore> |Z|
Cycle: <ignorex ﬂ Deductibility: <ignore> -
Event: 2016 Celebrity Galf Tournament |Z| Exclude Event: [< ignore= v]
Amount Range:  minimum » to maximum - Alloc. Fund: |<ign0re> |Z||
Batch Code:

[ Format ~ 53 Wrap D'E Export & Print @ Pivot

Contributions [ 136 records found ]

Resu Its jin] Date *  Last Name Zi“t MI Amount Deposited flou flou Check # Street
ame Letter Date Call
Sent Done
40.00 ” County Rd 5 NW
46491 8/2/2015 || Zwack James R 500.00 2/12/2016 4546 5419 50th Ave N
#1371 9/17/2014 || Jones Dannie Eugene 20,00 M/A PO Box 6
41263 9/5/2014 | H J 10.00 Aa
#1252 9/4/2014 || Mischke lennifer Marie 20,00 N/A 328 10th Ave N
41221 9/1/2014 || Qlsen Caitlin 10.00 M/A 100 10th St W
41220 9/1/2014 || McCready Holly 10,00 M/& 258 Green Grass Ave
41219 9/1/2014 || Mayayosnand Jessica 15.00 M/A 9330 Martin Ave
4117 9/1/2014 || Kim Wayne 15.00 N/A 1546 Ocean View Rd
41216 9/1/2014 || Hill Laura 15.00 M/& 95674 Mountain Top Rd
41215 9/1/2014 || Guzman Warilu 20,00 N/A 1222 Ultima Rd
41214 9/1/2014 || Gile Mangy 10.00 M/& 1584 85th Ave S
4121 9/1/2014 || Bleau Lillie 10.00 M/& 6588 Edgewood Dr
41210 9/1/2014 || Binns Zach 20,00 N/A 358 Georgetown Ave
41187 8/30/2014 || Bey Darleng Joann 2000 /A 5023 34th Ave N
41135 8/21/2014 || Bell Steve 10.00 M/A PO Box 1383
41091 8/17/2014 || Jones Dannie Eugene 20.00 N/A PO Boxé
5583 8/12/2014 || NA Trail Blazer ... 2,715.00 2/1/2016 620 Mendelssohn Ave N
5582 812/2014 || Kristenson Joel Anders 2,965.00 3A/3016 9110 Golden Valley Rd
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You'll only be sending to people who have an email address that’s enabled for mass email so you’ll want to add that to your search query as well.
Navigate to the Contact (Voter/Donor) tab > General > E-Mail > Plug it in > Select the Present radio button > Click [Search] to refresh the list.

(Example below where the query now filters by donations at the event and only people who have an email present).
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5

-
lfa:)Search hReset 4F New o | & File = Edit = |« | Applyto Pledges | Contributions

or | Other | Gat Contact =

# General | Address | Houseffpid | Attnbute | Canvass | Relation | Contiibute | Pledge | Event | Sales | Log |
| Name | Phone | . E-Mail |[Emai Links | Profile | Work | Demographics | User, Text | User, Dates | User, Decimal | Other |
IRNY 2
/’ @ () Address Address Type Subsecribed Abuse Complaints Unopened Messages
Primary = Mot Subscribed Exclude Complaints | <ignore> -
3
Alternate Unsubscribed Awaiting Opt-In 50
;“‘" Present Bounced Exclude Awaiting
47 O Mesn Exclude Bounced
%E Edit | [ Format ~ 53 Wrap BE Export &Print @Pivot |

Resu Its (o] = Last Name Amount Deposited \C Check # Street
46575 5/20/2016 [ Swanekamp loan 40,00 ” 7255 County Rd 5 NW

46491 8/2/2015 || Zwack James B 500.00 2/12/2016 4546 5419 50th Ave N
41187 5/30/2014 || Bey Darlene Joann 20,00 M/A 5923 34th Ave N
5583 §/12/2014 || NA Trail Blazer ... 2,715.00 2/1/2016 620 Mendelssohn Ave N
5582 8/12/2014 || Kristensan Joel Anders 2,965.00 2/1/2016 9110 Golden Valley Rd
5581 8/12/2014 || Kristenson loel Anders 265.00 2/1/2016 9110 Golden Valley Rd
5579 7/30/2014 || Jack Kangaroo 10.00 2/1/2016 123 Hennepin Ave
40835 7/16/2014 || Cox Eobby 17.00 /A 2710 Florida Ave N
40522 6/12/2014 || Akemann James Michael 15.00 M/A 1021 Westwood Dr
40004 4/28/2014 || Heaton William F 14.00 M/A 609 19th 5t 5
39820 4/12/2014 || Homan Donna M 20.00 M/A 221 Ledlie Ln
39598 4/2/2014 || Goettsch Kenneth Allen 20,00 /A 22340 Panama Ave
39355 3/8/2014 || Nelson Greag Edwall 20,00 M/A 6700 Hillside Ln
39168 2/24/2014 || Kay Hatalie Lynn 14,00 M/A 4125 Goldenrod Ln N
38995 2/10/2014 || Hook Diania leanne 20,00 /A 5113 Eleanor Ln
38707 1/22/2014 || Uhlenkamp-Br... | Lynn M 10.00 M/A 13822 211th Ave NW
38614 1/16/2014 || Naguin Kimberly 10.00 M/A 222 Southfield

| 38580 1/14/2014 || Howard Marilyn B 10.00 MN/A 807 4th Ave SE
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Select File > Create Mass Email...
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<3v Search % Reset | 4k New o= k) ¥ @ File «| Edit - | /| Applyto Pledges | Contributions
Apply Against Open Pled

@I I pply Against Open Pledges

| Favaorites | General | Memary/Hanar | Other I Eaeway| Contact Create Mass Email... |

TNTILE LELLE o
Set Thank You Sent...
Set Thank You Phaone Call...

A General | Address | Household | Attribute | Canvass | Relation
Name | Phone | #* E-Mail | Email Links | Profile | Work | Democ
b @' Print...

@ (™) Address Address Type Sub Print Preview... Unopened Messages

Primary = Mot [ <ignores

Alternate Tid Uns Update Cycle... 0
Present Bou Update Event..,

(0 Missing Exc Update Payment Method...

mal | Gt |

Set Tax Deductible Amount
Add Allocation Fund

Export...

=4 Edi .2 @ - -
S8 Edit | Sort T Format - S3Wrap | &% Export &2 Print | [ Pivot |
Contributions [ 20 records found ]

¥ Last Mame Amaount Deposited Check #

5/20/2016 ”Wl?lilm"lilili

8/2/2015 James 500.00 212/2016
5,/30/2014 Darlene
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Give the email campaign a name and click [OK].
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1. Give the email campaign a name.

Create a New E-Mail Campaign

E-Mail Campaign ‘
[El MName: Event Thank-You (Contribution Total) - 2016 Celebrity Golf Tournament (9/20/16)

Campaign Mame Created

I Demonstration of links 12/17/2010
5 Asking Matters 01/17/20M
5 Test Donation Thank-You 10/06/2014
ITJDELETE LATER 06/28/2016

Details

@ Contacts Addresses

(@ Everyone included in cument list Primary address

Everyone in database Altemate address
Everyone in search favorite: (@) Primary address if available, otherwise atemate

Bath primary and atemate addresses

Exclude/Confirm
Far those addresses to which |20 or maore messages have been sent since the
|zst registered open:
Bypass sending the e-mail message.
Send the e-mail message, but include a request for corfimation of interest in continuing to
receive e-mail. (Further e-mail will await a response to this request )

Click here for a detailed explanation of this feature.

11

Remove Duplicates (not recommended for personzlized emails)
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Click Edit > Mail Settings... in the upper-left of the email composer.

1

File ~| Edit ~|| «/ |5 Saved Copies [@] Results i) B3 & | Event Thank-You (Contrib

From. Mail Settings... n
To: 19 Recipient|s) \

Subject:

. Edit | Save E?@Insv&:r’c Template | Save Template | Priority Normal ~ [ | Forward to Frie
xLasthlames - Filter Content

=

Bsouce @ @[ X B B «

B I USXx x L

| Styles - || Mormal

Select your event you’re sending out a receipt for and click [OK].

KNOWLEDGE BASE www.trailblz.com/kb 12



http://www.trailblz.com/kb

& TrailBlazer

Organtze, Leverage. Succeed. How to Use the <<EventContributionTotal>> Merge Field in Mass Email to
Thank Attendees for the *Total* Amount they Gave at a Specific Event — 2016 Upgrade

Mail Properties

Settings

ser Information

Mame: Demo Monprofit Joel
COrganization: Demo Monprofit Joel
From Address: jkristenson@trailblz.com

Reply Address: jkristenson@trailblz.com 1

Other
Event: 2016 Celebrity Golf Tournament

2 G

Create a Subject Line and compose your message, my example is below. If you’ve previously created a template you can insert it, or you could start
with one of the built-in ‘Standard Trail Blazer Templates’.
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File » Edit v |/ | Saved Copies [@] Results | [£J [ EJ E | Event Thank-You (Contribution Total) - 2016 Celebrity Golf Tournament (9/20/16)

From: jkristenson@trailblz.com 1 create a Subject I.ine
To: 19 Recipientis)

ESubjec:t: Thanks for coming to our big event! (tax-receipt enclosed)|

A Edit H Save E?glnsertTemplate L—_I Save Template | Priority Mormal - [ Forward to Friend [7] Unable-to-Read Link

«Suffises - Filter Content |

Bswce R @| % h BB « ~/[Qby = w

[Bl7i usxxg]e:=:€»3Bsz==Msls|Bms e a s
| Styles - || Nomal || Font - || size ~| A~ ﬂ-|

2. Compose| your email
(or insert one of the Standard

Trail BlazerTemplates or one & TroilBlazer

Onganize. Leverage. Succeed.

that you've|saved previously).

m

Thanks for your support at our big event!

PDear «FirstName» «LastNamex»,

PThanks for coming to our event, it was a huge success and broke all expectations!

Here's a copy of your tax-deductible contributions:

Total: B

PLet us know if you have any questions. We look forward to seeing you there next
year when the event will be even bigger and betterl

PSim:erly, 14

Joel Kristenson

Wl b o ot m it AL 3 A B Al R 3 B Bl At 3 e e e
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Put your mouse cursor in the area of the email where you want the event contribution total to populate, then select the merge-field drop-down
and click on the one called <<EventContributionTotal>>.

KNOWLEDGE BASE www.trailblz.com/kb 15
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File ~ Edit ~ | 0 | Saved Copies [@ Results | [ (@) E§ & | Event Thank-You (Contribution Total) - 2016

From: jkristenson@trailblz.com
To 19 Recipient|s}

Subject: Thanks for coming to our big event! (tax-receipt enclosed)

o Edit | Save EElnse plate | Save Template | Priority Normal - [] Forward to Friend [7] Unable-to-Reg

|«:5L.Ifﬁ)(:c- |v| Filter Content
[ «Occupations= -
""""""""""" D E G Qb E
«EmailAddress» . H il ¥ | ]
«AltEmailAddresss 1= = | = ge o |—= 1 = g = ’ 1 =F.
«Phone_Alts L= = =& » S [EE = = |9 15 | |_E
=Phone_Cell» | ] )
«Phone_Homes ;| | e N ‘ | EEE | | A' E' |
«Phone_Faxs
«Phone_Buss
«Phone_BusFaxs
«ContributionLastDates
PR T . "
| < & TrailBlazer
«Userd01» 3. This is the new "~ Organize. Leverage. Succeed.
serdOs merge field that will auto-populate
wl )5 e o
=User004s = rwith the total contribution amount the
alJserd05:
User006 donor gave at the event you selected.
alJserd07»
«UserJ08- -
e e, | Thanks for your support at our big eve
xlserl10=
alJser(lls
alJser(l2s
""""""""""" F R
«BirthDate» Dear «FirstName» «LastName»,
P . .
Thanks for coming to our event, it was a huge success and br¢
Here's a copy of your tax-deductible contributions:
1. Insert your mouse cursor wh bwant 16
Total: <4 the event contribution total merge field to go.
a1 F'I ot e o 1if von have any Aanectinne W e lnnle fonward to oo
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Below is an example of what the merge field should look like once it’s inserted.

KNOWLEDGE BASE www.trailblz.com/kb 17
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File = Edit -  Saved Copies [@ Results (@ B3 E | Event Thank-You (Contribution Total) - 2016 Celebrity Golf Tournament (9/20/16)

jkristenson@trailblz.com
19 Recipient(s)

Subject: Thanks for coming to our big event! (tax-receipt enclosed)

Edit H Save '-'fﬂlnsert Template H Save Template | Priority Mormal - |:| Forward to Friend |:| Unable-to-Read Link

«EventContributionTo |'| Filter Content

@ Source | @ @ B @ Q b3 | E | %
BIUSX Xx L iz %«»8[Efs==sF1g = BEm=060=
Styles - Normal - Font - Size -~
Thanks for your support at our big event!
F'Dear «FirstName» «LastName=», |
g
F'Th:_-:nks for coming to our event, it was a huge success and broke all expectations! [

Here's a copy of your tax-deductible contributions:

Total: «EventContributionTotaly —<am—

F'Let us know if you have any questions. We look forward to seeing you there next
year when the event will be even bigger and betterl

m

F'Sin-:erlyi
Joel Kristenson

® Your Organization Name, MM, DD YYYY ' § - g = o e
" K1 P in

YourEmailAddress@email.com | 1-123-456-7891

L ARl EL o E A AT EL o E A Al EL s aa
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Run a test of the email by clicking the [Test] button in the bottom-right. If you need to set up more database users as email testers this article

shows how.

v Tip: It’s useful if ‘you’ are one of the people who gave to the event so that you can verify the total amount populates correctly in your test email
prior to sending to everyone in the list (if you’re sending to multiple recipients).
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File = Edit -  Saved Copies [@ Results (@ B3 E | Event Thank-You (Contribution Total) - 2016 Celebrity Golf Tournament (9/20/16)

jkristenson@trailblz.com
19 Recipient(s)

Subject: Thanks for coming to our big event! (tax-receipt enclosed)

Edit H Save '-'fﬂlnsert Template H Save Template | Priority Mormal - |:| Forward to Friend |:| Unable-to-Read Link

«EventContributionTo |'| Filter Content

@ Source | @ @ B @ Q b3 | E | %
BIUSX Xx L iz %«»8[Efs==sF1g = BEm=060=
Styles - Normal - Font - Size -~
Thanks for your support at our big event!
F'Dear «FirstName» «LastName=», |
g
F'Th:_-:nks for coming to our event, it was a huge success and broke all expectations! [

Here's a copy of your tax-deductible contributions:

Total: «EventContributionTotal»

F'Let us know if you have any questions. We look forward to seeing you there next
year when the event will be even bigger and betterl

m

F'Sin-:erlyi
Joel Kristenson

® Your Organization Name, MM, DD YYYY ' § - g = o e
" K1 P in

YourEmailAddress@email.com | 1-123-456-7891

L ARl EL o E A AT EL o E A Al EL s aa
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Select who to send the test to and click [OK].

TestE-Mail Campaign

The included individuals belowwll receive a test e-mail message.
Do you wish to proceed?

D& Export & Print |

Recipients to Receive Test Message

E-mail Address

support@trailblz.com

Click [Close] after you get the message that your test has been submitted.

KNOWLEDGE BASE www.trailblz.com/kb

21


http://www.trailblz.com/kb

& TrailBlazer

Organtze, Leverage. Succeed. How to Use the <<EventContributionTotal>> Merge Field in Mass Email to
Thank Attendees for the *Total* Amount they Gave at a Specific Event — 2016 Upgrade

Campaign Submittal T

" Atestrun of campaign "Event Thank-You
(Contribution Total) - 2016 Celebrity Golf
Tournament (3/20/16)" has been

submitted for sending -- thank youl

Here’s what my example looked like:

KNOWLEDGE BASE www.trailblz.com/kb 22
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From: Demo Monprofit Joel <jkristenson@trailblz. com = sent:  Tue 9/20/2016 4:40 PM
To: Joel Kristenson
Cc
Subject: Thanks for coming to our big event! [tax-receipt enclosed) [Test 2]
Ea
Fs

Thanks for your support at our big event!

Dear Joel Kristenson,

Thanks for coming to our event, it was a huge success and broke all expectations!

Here's a copy of your tax-deductible contnibutions:
‘Event Contribution Total' merge-field
Total: $3,230.00 eff—

in action.
Let us know if you have any questions. We look forward to seeing you there next
year when the event will be even bigger and betterl

Sincerly,
Joel Kristenson

® Your Organization Name, MM, DD YYYY

YourEmailAddress@email.com | 1-123-456-7891

@ See more about: Joel Kristenson.
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« Tip: If you want to verify the amount is populating correctly you can search the Contributions list by a single recipient who gave to your event.
Then verify the total in the database matches what they receive in their email. My example is below where the total correctly equaled 53,230.00:

KNOWLEDGE BASE www.trailblz.com/kb 24
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03 | Ele ~ Edit ~ e
<3 Search . Reset | 4p New (il = B File = Edit | Applyto Pledges = Contributions |
Q

|Fa1rmi&s|ﬁenerd|Memmyf’Hmmlmler |Gaeway| Contact |SQL |

4 General | Address | Household | Attribute | Canvass | Relation | Contribute | Pledge | Evert | Sales | Log |

4 Name | Phone | /F E-Mai | Email Links | Frofile | Work | Demographics | User, Text | User, Dates | User, Decimal | Other |

Q
Individual Last Mame: Kristenson - Search =l name paris Title:
Corporation First/Org Mame: ~  [(anywhere in field) Suffie: -
Foundation Middle Mame: -
Mickname:
Prior Last Name:

=8 Edi - S5 la i i
8 Edit &£ Sort B Format ~ 53 Wrap a Export & Print | Pivot |
Contributions [ 2 records found ]

Thank Thank Thank
= First ) You You Street
i} Date = Last Name Name AT Amount Deposited Lattar ‘E‘)m; call Check#  Street 3
Sent ate Done

5582 8/12/2014 || Kristenson loel Anders 2,965.00

2/1/2016 9110 Golden Valley Rd Apt10 |

v
[ 5581 8/12,/2014 || Kristenson Joel Anders 265.00 ” 27172016 9110 Golden Valley Rd Apt 10 |
@] EEZ] IR R R S

Tip: To verify the merge field is working you can
filter the 'Contributions’ list to show a single
wowtence saSUMAMkEREIRIGRt Who gave to theevent and

the total in this list should match what they
receive in the masc email cambaian.
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Once you're satisfied with the test results you can either schedule the campaign to go out in the future or send it right away. To bring up these
options you'll start by clicking the [Send] button in the bottom-right of the email composer, select your options, and click [OK]. My example is
below to schedule the campaign for the 10/1/16.
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File = Edit = | / |5 Saved Copies [@] Results in| (3]

|| From: jkristenson@trailblz.com
To: 19 Recipient(s}

Subject: Thanks for coming to our big event! [tax-receipt enclosed)

1

o Edit [ Save EEIr‘lser‘c Template | Save Template | Priority Mormal - [C] Forward to Friend [] Unable-to-Read Link
«EventContributionTo ~ Filter Content

Bsoce @ @[ X D B @ « +||Q b3
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L ]
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]
82
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]
1]
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Schedule E-mail Campaign =

Your message will be sent to 19 recipients.

2. Either 'send now' or
() Send now Ischedule' it for the futurE. | Ventl

@ Send at scheduled time
10/ 1/2016 04:52 PM = {(UTC-06:00) Central Time (S

)
3
| [Dcancel |

OK

broke all expectations!

m

Here's a copy of your tax-deductible contributions:

Total: «<EventContributionTotal»

F'Let us know if you have any questions. We look forward to seeing you there next
year when the event will be even bigger and betterl

"Sincerly, 27
Joel Kristenson

body table tbody fr td table thody fr td table thody fr td p


http://www.trailblz.com/kb

& TrailBlazer

Organize, Leverage. Succeed.
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The related resources below link to a large variety of articles and videos on the mass email and event features.

999

Trail Blazer

- YouTube Channel
- Knowledge Base Articles
- 3rd Party Resources
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Related Resources

Article:
Article:
Article:
Article:
Article:
Article:
Article:
Article:
Article:
Article:
Article:
Article:
Article:
Article:

Configuring your From and Reply Email Address Settings

How to Create Custom Email Responders for Specific Events — New 2016 Feature Upgrade

How to Access and Use the Standard Trail Blazer Email Templates as a Starting Point for Template Creation and Mass E-Mail Campaigns

How to Create a Custom Thank-You Auto-Responder Email with Merge Fields for your Online Donation Form

How to Cancel a Mass Email Campaign as it’s Going Out & How to Reschedule a Queued Email Campaign

Sending Out Test Emails

Deleting an Email Campaign

How to Create a Hyperlink around a Screenshot of your PDF Newsletter and Hyperlink it to the PDF Document

How to Create a Hyperlink around a Screenshot of your Video and Link to the Video from your Trail Blazer Email Template

How to Import a Google Web Font into your Trail Blazer Email Template

Sample HTML Email Templates with Inline CSS

Events 2014 — Part |

Events 2014 — Part |l

Events 2013 | How to Create an Event with Tickets and Merchandise

Video: Eblasts —Setting people up to receive test (draft) emails

Video: Thank You’s using mass email
Video: Scheduled Emails
Video: Eblasts Create and Send Eblasts — Includes Image Management

Video: Eblasts Configure email settings before mass emailing
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http://trailblz.com/kb/?action=view&kb=258&cat=1
http://trailblz.com/kb/?action=view&kb=327&cat=1
http://trailblz.com/kb/?action=view&kb=325&cat=1
http://trailblz.com/kb/?action=view&kb=329&cat=1
http://trailblz.com/kb/?action=view&kb=314&cat=1
http://trailblz.com/kb/?action=view&kb=207&cat=1
http://trailblz.com/kb/?action=view&kb=200&cat=1
http://trailblz.com/kb/?action=view&kb=267&cat=1
http://trailblz.com/kb/?action=view&kb=263&cat=1
http://trailblz.com/kb/?action=view&kb=332&cat=1
http://trailblz.com/kb/?action=view&kb=238&cat=1
http://trailblz.com/kb/?action=view&kb=253&cat=1
http://trailblz.com/kb/?action=view&kb=256&cat=1
http://trailblz.com/kb/?action=view&kb=102&cat=1
https://www.youtube.com/watch?v=x-rF7-WH5ls
https://www.youtube.com/watch?v=6KZq8LCXsZI
https://www.youtube.com/watch?v=3R3eWcuniJs
https://www.youtube.com/watch?v=QAAvHVxFHww
https://www.youtube.com/watch?v=pCISGEiXh-c
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Video: Donation Auto Responders with Merge Fields
Video: Events 2013
Video: Events — pay for an event online

Video: Events — Remove Person from Event

Trail Blazer Live Support

© Phone: 1-866-909-8700
® Email: support@trailblz.com

E? Facebook: https://www.facebook.com/pages/Trail-Blazer-Software/64872951180
B Twitter: https://twitter.com/trailblazersoft

* As a policy we require that you have taken our intro training class before calling or emailing our live support team.
Click here to view our calendar for upcoming classes and events. Feel free to sign up other members on your team for the same training.

* After registering you’ll receive a confirmation email with the instructions for how to log into the GoToMeeting session where we host our live
interactive trainings.

* This service is included in your contract.

KNOWLEDGE BASE www.trailblz.com/kb 30



http://www.trailblz.com/kb
https://www.youtube.com/watch?v=XQhVau54b48
https://www.youtube.com/watch?v=5FVnO1WJQc8
https://www.youtube.com/watch?v=De9dkY7S8xE
https://www.youtube.com/watch?v=-1Zy2YkbQak
mailto:support@trailblz.com
https://www.facebook.com/pages/Trail-Blazer-Software/64872951180
https://twitter.com/trailblazersoft
http://trailblz.com/Support/Learning/Events.aspx
http://www.joingotomeeting.com/
http://www.google.com/url?sa=i&rct=j&q=&esrc=s&frm=1&source=images&cd=&cad=rja&docid=OWWX4dkzm0Ht9M&tbnid=fvnmGEIR8WcqlM:&ved=0CAUQjRw&url=http://sisyphus-js.herokuapp.com/&ei=8c93UqrcFYj_qgHr4oGADw&psig=AFQjCNEn8KDSLHIodKJmcApCrvnIZvl23g&ust=1383670048026187
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